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Additional Documentation

The Ascent Capture 7.5 Service Pack 3 notes supplement the Ascent Capture 7.5 release notes.

Important Information About Ascent Capture 7.5 Service Pack 3 Notes

Ascent Capture 7.5 Service Pack 3 is a cumulative package and contains all features and problem
resolutions from the previous Service Pack. Therefore, Service Pack 3 will also contain information
from Service Pack 1 and Service Pack 2.

New Features

This section contains information about a new feature provided with this Service Pack.

Digital Certificate Support

You can now enable Digital Certificate authentication within your Ascent Capture Internet Server
installation. To enable Digital Certificate support, you must first identify the certificate and then
enter its value into the Windows Registry using the following instructions. Digital certificate
authentication has been certified on IIS 6.0 and Internet Explorer 6.0. (SPR 00028598)

Note It is assumed that the digital certificate is installed and configured on your IIS server prior
to implementing this feature.

1 Obtain the Digital Certificate Thumbprint value:

a On the computer running the Remote Synchronization Agent (RSA), open Internet
Explorer.

b On the Tools menu, click Internet Options, and then click the Content tab.
Click Certificates, and then click the Personal tab.

Select the digital certificate that allows you to access the Ascent Capture Internet
Service (ACIS) Web site, and then click View.

e Click the Details tab.

f  Scroll down until you see the Thumbprint field. You can now view the details of the
selected digital certificate, which are in hexadecimal code format, such as OE 47 CF 93
4B and so on. Copy the hexadecimal code to an application such as Notepad, or print
the hexadecimal code. You will need it in the next step.

2  Enter the Thumbprint value into the Windows Registry:
a On the Taskbar, click Start, and then click Run.
b Type “Regedit”, and then click OK. The Registry Editor will display.

¢ Navigate to the following subkey: HKEY_LOCAL_MACHINE\ SOFTWARE\ Kofax
Image Products\ Ascent Capture\3.0.
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On the Edit menu, click New, and then click Binary Value.
Type the name “Thumbprint” for the new entry and then press Enter.

Right-click the Thumbprint entry and select Modify from the menu that displays.

Q - 0 o

In the Value Data field, enter the hexadecimal code values from Step 1 and then click
OK.

h On the File menu, click Exit.

Problems Resolved

This section contains information about issues that you can resolve by installing Ascent
Capture 7.5 Service Pack 3.

Changing the Ascent Capture Password When the SQL Server Password Is Changed

Previously, you could not use the Ascent Capture Database Utility to change the password to the
SQL Server database when the password for the SQL Server was changed.

Now, if the password for the SQL Server database is changed, the next time the Ascent Capture
Database Utility is run a dialog box in which you can enter the User ID and new password for
access to the SQL Server is automatically displayed. The Ascent Capture configuration is updated
so that the new SQL Server password is stored and recognized for subsequent access to the SQL
Server database. (SPR 0007742)

VRS Blank Page Deletion Erroneously Deleted Reverse Side of Duplex Image

Previously, when using Ascent Capture 7.5 patch code document separation with the separation
sheet discarded at scan time and with the VRS 4.1 Blank Page Deletion option enabled, the reverse
side of duplex images that were not blank were deleted beginning with the second and
subsequent separators.

This issue has been resolved. The reverse side of duplex images that have content is no longer
erroneously deleted for the above-described settings. (SPR 00025953)

Administration Module Inoperable When the Mailbox List Option Is Selected

If NET Framework 2.0 was installed and the Mailbox list option of the Ascent Capture Email
Import Service was selected, the Administration module would prematurely close.

This issue has been resolved, and the Administration module works as expected. (SPR 00026399)

User Tracking Database Is Not Updated with the Correct Batch Process State Value

The wrong batch process state of “Ready” (instead of “Completed”) was assigned to a batch in the
User Tracking database under certain circumstances. The following process is an example of this
issue:

1 A batch error occurs in the Release module.

2  The batch is routed back to the Quality Control module.

3 The batch is resolved (unrejected) in the Quality Control module.
4

Through Batch Manager, the batch is routed back to the Release module and successfully
released.
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The batch was released, but the User Tracking database showed the batch in the “Ready” process
state instead of the expected “Completed” process state.

This issue has been resolved. The User Tracking database will now contain the correct process
state of “Completed” for the above described scenario. (SPR 00026440)

When Running XML Auto-Import with User Tracking Enabled, Reporting Captures the
Processing of the First File Only

When running XML Auto-Import with user tracking enabled, batch statistics were captured for
only the first batch processed. No batch statistics were captured for any subsequent batches that
were processed, and reporting was inaccurate.

This issue has been resolved, and reporting works as expected when running XML Auto-Import
with user tracking enabled. (SPR 00026700)

Bar Code Recognition

With the Recognition Server module configured to use the Enhanced Bar Code Engine (EBC), the
recognition accuracy may have been diminished when attempting to read a bar code. This issue
has been resolved. Bar codes that require the use of the EBC can now be read with the expected
degree of accuracy. (SPR 00027028)

Create Folder Option Disabled in Context Menu

Upon selecting multiple documents in the Validation module, and then right-clicking to create a
new folder, the Create Folder option was disabled in the context menu that displays.

This issue has been resolved and the Create Folder option is now available in the context menu.
(SPRs 00027424)

Same Batches Can Be Processed at the Same Time by More than One User or More than
One Unattended Module

More than one user or unattended module was able to process the same batch at the same time.
This led to subsequent problems both during and after processing.

With this service pack update, only a single user or single unattended module can access and
process any batch. (SPR 00027568)

Unattended Modules Fail to Restart

Unattended modules failed to restart due to a memory management issue. Batches were instead
sent to the Quality Control module with a “Host processor error.” To resolve this issue, you must
install Ascent Capture 7.5 Service Pack 3, and then install VRS 4.1, Service Pack 1. Afterwards, the
Recognition server will restart and continue processing batches. (SPRs 00027714 and 00027560)

Cannot Find eDoc Files Created at a Central Site

When attempting to process an eDoc file that was created at a central site, the following error was
displayed in the Remote Synchronization Agent dialog box:

“Cannot find <file>. Make sure the path or Internet address is correct.”
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You should no longer receive this error message when processing eDoc files. The file name path
has been resolved. (SPRs 00028079 and 00024430)

Caching Last User for User Profiles

When logging into Ascent Capture with User Profiles activated, the Login display defaults to
“Admin” for the User ID.

This issue has been corrected to cache the most recently-used account name for the User ID when
User Profiles is active. (SPRs 00028102 and 00027436)

Can't Run Custom Module at Remote Sites

If you attempted to run a Custom module at a remote site, an error message displayed indicating
that the Custom module was not properly registered. Additionally, if you registered the Custom

module prior to converting the system to a remote site, the system was unable to open batches for
processing.

With this service pack, the Custom module will be properly registered at a remote site and the
system can open batches for processing. You must re-register the Custom module.
(SPRs 00028242 and 00024756)

Release Module Stops Processing with Large Batches of Bitonal and Color Documents

When processing a large number of batches with bitonal and color documents, the Release
module sent all batches to the Quality Control module in error due to a memory issue and needed
to be restarted.

This issue has been resolved. You can now successfully process a large number of batches with
bitonal and color documents through the Release module. (SPRs 00028700 and 00026827)

Modules Terminate Due to Synchronization Errors

Modules terminate with routine synchronization errors during batch processing.

This issue has been resolved and routine synchronization works as expected.
(SPRs 00028701 and 00027739)

Installing Ascent Capture 7.5 Service Pack 3

This section contains important notes that you should review before installing Ascent Capture 7.5
Service Pack 3.

Important Note About Ascent Capture 7.5 Service Pack 3

The Ascent Capture 7.5 Service Pack 3 has been fully tested and certified with Ascent Capture 7.5.
However, as with any Service Pack, we recommend that you install and test Ascent Capture 7.5
Service Pack 3 in a development environment first before applying it to your production
environment. Note that we recommend that you review the Technical Support Web pages for any
late-breaking information and up-to-date certified operating system requirements. Visit the Web
site at www .kofax.com.
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Important Note About the Installation

In order to install Ascent Capture 7.5 Service Pack 3, you must have full Windows administrator
privileges.

The Ascent Capture 7.5 software must be installed prior to installing Ascent Capture 7.5 Service
Pack 3. Note that we recommend that you review the Technical Support Web pages for any late-
breaking information and up-to-date certified operating system requirements. Visit the Web site at
www kofax.com.

Note We recommend that you review the Ascent Capture 7.5 Release Notes before installing
Ascent Capture 7.5 Service Pack 3 as they contain important information about Ascent Capture,
including known limitations, certification information, installation requirements, and Windows
Service Pack issues.

Close All Applications

Before installing Ascent Capture 7.5 Service Pack 3, you must close all applications. This means
that all of the Ascent Capture modules on every workstation must be closed, including the Ascent
Capture Internet services, and any third-party applications. Note the following:

» If the remote sites have any Ascent Capture services running, you must stop these services
before installing Ascent Capture 7.5 Service Pack 3. Note that the services must remain
stopped until Ascent Capture 7.5 Service Pack 3 is installed.

s We recommend that you stop all Ascent Capture modules running as a service, including
the Ascent Capture Licensing Service (Ascent Capture Service), Recognition Server, and
Ascent Capture Email Import Service (ACEI Service). The services must remain stopped
until Ascent Capture 7.5 Service Pack 3 is installed.

Installation Instructions for Ascent Capture 7.5 Service Pack 3

Use the following instructions to install Ascent Capture 7.5 Service Pack 3.

Note When installing Ascent Capture 7.5 Service Pack 3, you must update the server first. Then,
you can update the client workstations. For a server installation, the update must be performed on
the computer where the server software is installed. Client workstation, remote site, and
standalone installations must be updated on the computer where the current installation exists.

» To install Ascent Capture 7.5 Service Pack 3

1 Download Ascent Capture 7.5 Service Pack 3 from the Kofax Web site. The file that
downloads is a self-extracting executable that contains Ascent Capture 7.5 Service Pack 3.

2 Run the executable file to install Ascent Capture 7.5 Service Pack 3.

3 Follow the instructions on your screen. When the installation is complete, a message will
display that indicates Ascent Capture 7.5 Service Pack 3 was successfully installed.

Note If you are performing a Service Pack installation on an existing Ascent Capture Internet
Server at the central site, the Service Pack will be made available to the remote sites via the Remote
Synchronization Agent (RSA) upon completion of the installation. Note that the Service Pack
installer will be located in the Ascent folder.
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Uninstalling Ascent Capture 7.5 Service Pack 3

This section contains important notes that you should review before uninstalling Ascent
Capture 7.5 Service Pack 3.

Note that when you uninstall Ascent Capture 7.5 Service Pack 3, you are returning the
workstation back to its original state before any Ascent Capture Service Packs were applied.

Administrative Privileges

In order to uninstall Ascent Capture 7.5 Service Pack 3, you must have full Windows
administrative privileges.

Uninstallation Instructions for Ascent Capture 7.5 Service Pack 3

Use the following instructions to uninstall Ascent Capture 7.5 Service Pack 3.

» To uninstall Ascent Capture 7.5 Service Pack 3

1 Start the uninstallation as follows:

= For Microsoft Windows XP, select Start | All Programs | Ascent
Capture 7.5 | Uninstall Service Pack 3.

= For other operating systems, select Start | Programs | Ascent Capture 7.5 | Uninstall
Service Pack 3.

2 Follow the instructions on the screen to uninstall the Ascent Capture 7.5 Service Pack 3.

Note Ascent Capture 7.5 Service Pack 3 is installed as a component of the Ascent Capture 7.5
program. Therefore, Ascent Capture 7.5 Service Pack 3 will not display in the list of installed
programs in the Add or Remove Programs utility from the Windows Control Panel.

Problems Resolved in Ascent Capture 7.5 Service Pack 2

This section contains information about issues that you can resolve by installing the previous
Service Pack. Note that Ascent Capture 7.5 Service Pack 3 is a cumulative package and will also
contain information from Ascent Capture 7.5 Service Pack 2.

KfxOcxEventBatchRejecting Event

You can now successfully cancel the KfxOcxEventBatchRejecting event and close the batch
without an error. In the previous release, the batch reject flag was not cleared when the
KfxOcxEventBatchRejecting event was cancelled. Therefore, if you attempted to suspend the
batch, you would receive an error message. In addition, if you attempted to create a document to
fix the loose pages, you would receive an error message and the batch would be routed to the
Quality Control module. (SPRs 00022618, 00026787, and 00026788)

Folder Validation

You can now successfully use the Validated property for a custom panel to validate folders and
documents in a batch. In the previous release, when a custom panel was set with this property
equal to “True,” documents were not skipped in the Validation module.

(SPRs 00024952, 00026789, and 00026790)
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Increasing Sample Rate

You can now successfully increase the Sample Rate on the Options dialog box in the Scan module
and the view window will display the pages. In the previous release, when the Sample Rate was
greater than one, no images were displayed in the view window. (SPRs 00027309, 00027697,

and 00027698)

International Environments

ACI Server remote sites can now have different regional settings other than the central site. Prior
to this release, the import and export date and time format did not include the universal time
coordinate. (SPRs 00020297, 00022623, 00026129, 00027445, 00027446, and 00027447)

Error While Synchronizing Batch Classes

The Ascent Capture Internet Server (ACI Server) will now read non-standard characters. In the
previous release, the following error message was returned when a batch class configuration file
contained delimiters that did not fall within the default character set. (SPRs 00025489, 00027699,
and 00027700)
Error while synchronizing batch classes: (-2146232000). Error while transferring file
(Ascent\PubTypes\00000001.PUB\00000001.unv) from server (*“,hexadecimal value 0Ox1D, is

an invalid character. Line 10, position 26.), Station ID: LONAPDMGDEMO
(LONAPDMGDEMO) .

Object Deleted Error Message

A problem with simultaneous display of the Open Batch dialog box on two workstations has been
resolved. Prior to this release, the first workstation would process the batch and release
successfully. However, when the second workstation attempted to process the same batch from
the Open Batch dialog box, the following error message would display. In addition, when the user
attempted to close the error message, the application would also close. (SPRs 00027443. 00027701,
and 00027702)

Object deleted error - object deleted.

Switching From MSDE to SQL Server

A problem with switching from a Microsoft MSDE database to a SQL Server database or vice
versa has been resolved. In some cases, records were not copied to the new database and the
following error message would display. (SPRs 00022603 and 00027474)

The requested object could not be found on the database. The database must be
refreshed.

Collection of CustomProperty Objects

You can now successfully view the collection of CustomProperty objects via the Ascent Capture
APIL Prior to this release, you could not access these properties in a custom module, such as the
sample OCXPanel shipped with Ascent Capture. (SPRs 00025994 and 00027703)

Image Folder

During remote synchronization, an error message will now display when the Ascent Capture
Internet Server (ACI Server) is not able to access the image folder in a batch. (SPR 00021401)
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Data Entry Mode

A problem with the Data Entry mode has been resolved. In the previous release, when you
switched from the Batch Editing mode to the Data Entry mode, the batch editing functions
remained active. (SPRs 00026590 and 00026812)

Ascent Capture Email Import Service

You no longer need to manually restart the Ascent Capture Email Import Service (ACEI Service)
after the installation of an Ascent Capture Service Pack. The ACEI Service will automatically
restart after the installation. (SPRs 00022550 and 00022703)

New Features in Service Pack 1

This section contains information about a new feature provided with Ascent Capture 7.5 Service
Pack 1.

Time Zone

Batches that are transferred to an Ascent Capture site in a different time zone are now correctly
adjusted to local time zone differences. Therefore, a batch created at 7:00 a.m. Pacific Time in
California will display a time of 10:00 a.m. Eastern Time when transferred to New York. In the
previous release, the batch date and time values were not adjusted for the time zone difference
when the batches were transferred between sites. (SPR 00025084)

Note that the system administrator can configure the default batch name to automatically include
the local time zone. The default batch name will then display as:

<current date and time> <time zone indicator>

Where:

= <current date and time> is the date and time setting from the Windows Control Panel.

»  <time zone indicator> is the difference between Greenwich Mean Time (GMT) and the local
time. Note that the value is prefixed with a plus sign “+” or minus sign “-” to demonstrate
the counterbalance (for example, -07:00). The time zone indicator only displays the hours
and minutes.

This feature changes the following components:

= User tracking statistics: Time for the user tracking statistics will display the local time zone
at the central site.

= Batch Manager module and Open Batch dialog box: The “Date” column heading has been
changed to “Date & Time” to reflect the batch creation date and time.

= Batch Properties dialog box - General tab and Create Batch dialog box - General tab: The
batch creation date and time are displayed according to the local time zone.

= Batch Properties dialog box - History tab: The batch history date and time are displayed
according to the local time zone.

Date and time settings are formatted according to the Regional and Language Options in the
Windows Control Panel.

Warning All the workstations at the local site must be on the same time zone.
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Problems Resolved in Ascent Capture 7.5 Service Pack 1

This section contains information about issues that you can resolve by installing the previous
Service Pack. Note that Ascent Capture 7.5 Service Pack 3 is a cumulative package and will also
contain the information from Ascent Capture 7.5 Service Pack 1.

Folder Index Field Values

The Validation module will no longer move folder index fields down when using a SQL Server
database. In the previous release, when you created a folder, indexed the fields, and then
suspended the batch, the Validation module would move the fields down. In other words, the last
index field would become the first index field and each subsequent index field would move down
one row. The problem was more apparent on a SQL Server 2005 32bit Edition. (SPRs 00026289
and 00026402)

Recognition Server Module

The Recognition Server module will now successfully process all the documents in a batch. In the
previous release, when using page-level bar codes, separation would occur correctly; however,
only the first and last documents would contain data for the index fields. (SPRs 00025503

and 00025799)

Memory Leak

You can now successfully process a large number of batches with color documents through the
Release module. Prior to this release, the Release module would experience a memory leak when
processing a large number of batches with color documents on a dual processor system. As a
result, the Release module would display an error message similar to the following.

(SPRs 00024916, 00025564, and 00025565)

CKFxException: 0x00000230 FPS Color: An unspecified error occurred. The image could be
an unsupported file format.

Ascent Capture Email Import Service

The Ascent Capture Email Import Service (ACEI Service) will no longer display the following
error message and then stop responding. (SPRs 00025464 and 00025487)

An error has occurred while logging onto Ascent Capture: Querylnterface for interface
Kofax.AscentCaptureModule._ImportLogin failed.

Front Delete Blank Page Threshold

When using the “Front delete blank page threshold” option with patch code separation enabled,
the pages following the deleted separator sheet will now successfully separate. (SPRs 00025477
and 00025547)

Defining Index Fields on Sample Pages

A problem with defining index zones solely on the second sample page has been resolved. In the
previous release, you would need to define index zones on the first and second sample pages. If
you only defined index zones on the second sample page and not the first, the data from the zones
would simply be ignored at data capture time. (SPRs 00019057 and 00025815)
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Importing XML

Blank batch fields that are not required will no longer be replaced with a “????”string when the
custom module imports the XML. In the previous release, when you viewed the properties of the
batch in the Batch Manager module, you would notice that the blank field would display with
the “????” string. (SPRs 00024804 and 00025816)

Batch Totals

You can now successfully enter a batch total that has a value greater than 999 on the Totals tab and
then change focus to another tab. In the previous release, when the focus was removed from the
Totals tab on the Create Batch dialog box, you would receive an “Invalid Number” error message.
The problem occurred because the Totals tab was not able to go through the proper sequence of
events to save a batch value that was greater than 999. Therefore, when the Totals tab refreshed, it
would add commas to the value. For example, a batch total value of 1000.00 would

become 1,000.00. (SPR 00018170)

Page Level Bar Codes on Color Images

Page level bar codes will now be recognized on color images when the Enhanced Bar Code Engine
is not used. In the previous release, page level bar codes on color images were shown with no
values at Validation. (SPRs 00010360 and 00013895)

VRS QC Later

You can now successfully use VRS QC Later. In the previous release, when you attempted to open
a rejected page in the Quality Control module using VRS QC Later, an error message similar to the
following would display. (SPRs 00026068 and 00026193)

Unable to import electronic document. [32 — The process cannot access the file because
it Is being used by another process.

Remote Synchronization Agent (RSA)

The Remote Synchronization Agent (RSA) will now successfully download batches that contain
the backslash (\) and newline character. In the prior release, the RSA would return an error
message similar to the following when the batch contained the backslash and newline character.
(SPRs 00026356 and 00026307)

KdoLib: Value contains an invalid escape sequence. A backslash followed by a carriage
return or line feed is not permitted.

Refresh Tree Error Message

A problem has been resolved that caused an unnecessary error message to appear when a custom
panel was present in the Validation or Verification module. Prior to this release, the following
error message would appear each time a batch was closed. (SPR 00024753)

Refresh Tree Error -21474178748 Automation error. The object invoked has disconnected
from its clients. AscentCaptureModule O.
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Technical Support

For additional technical information about Kofax products, visit the Kofax Web site at

www .kofax.com and select an appropriate option from the Support menu. The Kofax Support
pages provide product-specific information, such as current revision levels, the latest drivers and
software patches, online documentation and user manuals, updates to product release notes (if
any), technical tips, and an extensive searchable knowledgebase.

The Kofax Web site also contains information that describes support options for Kofax products.
Please review the site for details about the available support options.

If you need to contact Kofax Technical Support, please have the following information available:

= Ascent Capture software version

= Ascent Capture Internet Server software version

= Operating system and Service Pack version

= Network and client configuration

= Copies of your error log files

= Scanner make and model

= Scanner engine (board) type

= Special/custom configuration or integration information
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